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Google Apps Information and Help
Background

Earlier this year, IT Services embarked on a plan to provide a way for people to easily share and
collaborate on documents and spreadsheets with each other in real-time. We also had two other
separate objectives we wanted to achieve - the provision of a more universally accessible electronic

forms system and the provision of low-cost storage.

A solution to all three of these objectives would have been Google Apps (now called G Suite), but while
the University had previously adopted Google Calendar, and it is possible to access this via Raven, no

other Google services were enabled.

| am pleased to announce that having requested, and made our case, for the greater use of Google Apps,
the UIS enabled this - not just for the Department of Physics - but across the University. Since it was
enabled for us two weeks ago we have been testing it and gaining feedback from early adopters. IT
Services is extremely appreciative of the efforts of colleagues in UIS who have worked with us on our

case and supported us in reaching the decision to enable these additional services.

The following Google applications are therefore now available to you (where linked further information

is available later in this document)

m Google Calendar

m Google Contacts (address book)
m Google Docs (and Google Drawings as part of Docs)
m Google Drive (free ‘unlimited’ cloud-based storage)

m Google Forms (for questionnaires, etc.)

m Google Hangouts (chat and video calling)

m Google Keep (personal and shareable notes and task lists)
m  Google Meet (videoconferencing - note that we haven’t tested this yet)

m Google Sheets (spreadsheets)

m Google Slides (presentation application)
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Known issues

m If you have previously purchased Google services (e.g. Google Drive) and used your @cam.ac.uk
email address with this, you may have difficulty using the Google Apps as it will not associate
your @cam.ac.uk address with your University of Cambridge Google service. If this is the case
you should contact us for further assistance. If you have had to request permission to access
this document with your @cam.ac.uk account, it means that Google does not recognise your
account as being part of our Google @cam.ac.uk domain, probably due to some previous

independent association with Google services from your @cam.ac.uk email address.

Logging in
Further information is available on the UIS website here:

https://help.uis.cam.ac.uk/email-telephony-and-collaboration/calendaring/googleapps/calendar

You can log into Google Calendar directly via a Raven login here:

http://gcal.apps.cam.ac.uk/

You can access your University Google Apps account directly by going to https://accounts.google.com -

if you are not already logged into a Google account within your browser this will present you with the

following screen:


https://help.uis.cam.ac.uk/email-telephony-and-collaboration/calendaring/googleapps/calendar
http://gcal.apps.cam.ac.uk/
https://accounts.google.com/
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& C ) @& Secure | https://accounts.g

Google
Sign in

with your Google Account

Email or phone

Forgot email?
More options NEXT
English (United States) - Help Privacy Terms

Enter your CRSid-based @cam.ac.uk email address (do ensure you include the @cam.ac.uk part of this):
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= C { & Secure | https://accounts.google.com

Google
Signin

with your Google Account

Email or phone

mm2228@cam.ac.uk

Forgot email?

More options m

English (United States) - Help Privacy Terms

Google
Sign in

with your Google Account

@ mm2228@cam.ac.uk =

English (United States] = Help Privacy

and click the button - this will take you to the University of Cambridge’s Raven login screen:
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- C {t & University of Cambridge [GB] | https://raven.cam.ac.uk

UNIVERSITY OF
% CAMBRIDGE

{ University Information Services / Raven

Raven

Login
BAVEN
User-id:
=
Password:
:

override login options for this session?

IE‘ Login >

ﬂ Help

The web resource you requested requires you to identify yourself [Help - why
am | seeing this?]. This resource is provided by the website
gauth.csx.cam.ac.uk. You should only proceed if you are happy to be
identified to this site.

Always quit your web browser when you have finished accessing services that
require authentication. Do not disclose your password to anyone. Please report
attempts to obtain your password in unusual circumstances. Raven necessarily
uses cookies to manage your authentication (details).

See help on Raven accounts if you want to change the password you use to log
in to Raven, if your password isn't working, or if you don't have a Raven account
but need one.

The Raven web authentication system is provided and managed by University

x cookie policy

You will then be at your account page. If you click on the ‘App Launcher’ in the top right, you will then

see some of the available Google Apps - note that more applications are visible after clicking the ‘More’

button.
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Shests Shides Calenda
Welcome, M. Moriarty

Control, protect and secure your a Q B
place i

Contacts
My Account gives you quick access 1o settings and tools that let you safegui - f

decide how your information can make Google services v

B Sign-in & security > & Personal info & privacy >

Google = 0 @

|
L

Hangouts Forms Keep
N “''>

Cloud Search
Welcome, M. Moriarty

Control, protect and secure your a
place

My Account gives you quick access to settings and tools that let you safegu
decide how your information can make Google services v

You have no Marketplace apps.

Meore from Apps Marketplace

ﬁ Sign-in & security > « Personal info & privacy >
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Data Storage

The University is increasingly storing or supporting the storage of data outside the institution on the
Internet (‘in the cloud’) - for example with Exchange Online (Microsoft UK/Ireland) and Dropbox
(Germany). You should be aware that at present no agreement is in place as to specific geographical
storage locations with our Google service. IT Services recommends that you are always mindful of

information you are storing, where this information is kept and its security.

Note that, according to Google “Every file uploaded to Google Drive is encrypted, not only from your device

to Google and in transit between Google data centers, but also at rest on Google servers.” [Link]

Google Calendar

Google Calendar has been provided within the University for a number of years. If you are not familiar

with it, you can learn more here:

https://gsuite.google.com/learning-center/products/calendar/

Google Docs

You can learn more about Google Docs here:

https://gsuite.google.com/learning-center/products/docs/

Templates

Generally, you will find that several Google Apps have templates you can use. For example:


https://googleforeducation.blogspot.co.uk/2014/09/announcing-drive-for-education-21st.html
https://gsuite.google.com/learning-center/products/calendar/
https://gsuite.google.com/learning-center/products/docs/
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<« C {d & Secure | https://drive.google.com

@ UNIVERSITY OF

CAMBRIDGE [riyve Q,  Search Drive
Googhe Apps @ Cambridge
Folder
b
b File upload I
rvices
Folder upload
anemeant
Bl Google Docs >
Blank document
Google Sheets >
From a template
Google Slides »
More »
. bridge Presentation Template
B B
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C 1t @& Secure | https://do ogle.com
Template gallery

GENERAL UNIVERSITY OF CAMBRIDGE

Education

CELLS SCIENCE LAB REPORT il

TEM PS4 00 T MET
BASIC UNITS OF LIVE hecniileoel ottt

Cat: The Ideal Pet

Essay Report
Playful a ack Simple

o CHp— wl_,_ Name of the book

Science Report

Report Book report
Playful by Reading Rainbow

Version History

A comprehensive version history of your document is maintained (menu: File>Version history), and you

can revert back easily to a previous version by clicking on it in the right-hand panel and selecting the

RESTORE THIS VERSION[s]tja{e]qH
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C {Y @& Secure | hitps

& Today, 12:00 Version history

Total: 1 edit Only show named versions .ﬁD

Today

» 27 October, 12:00 :
s Current version
I'T Services ey

Cavendish Laboratory

» 27 October, 09:44

H M. Moriarty
ITSM Team Meetings 77 October, 05:36
B M. Maoriarty
2017-11-01
Yesterday
Agenda
» 26 October, 16:57
m  Added this agenda item | M. Moriarty

» 26 October, 13:12
| M. Moriarty

26 October, 09:04
B M. Maoriarty

Wednesday

25 October, 09:57
H M. Moriarty

25 October, 09:14
| M. Moriarty

Google Drive

You can use Google Drive to store Google Apps files (e.g. documents and spreadsheets), as well as other
types of files. Currently there is a 5TB individual file size limit. Google Drive for Education (our service)

is marketed by Google as having ‘unlimited storage’ [Link].


https://googleforeducation.blogspot.co.uk/2014/09/announcing-drive-for-education-21st.html

. 2017-10-27.Google Apps Information and Help

<« C {d & Secure | https:/drive.google.com

@ UNIVERSITY OF

CAMBRIDGE  Drive Q
Googhe Apps @ Cambridge

i

L4 My Drive
=

[ =~ Team Drives
—
o Shared with me

©

Recent

‘.'. Google Photos
W  Starred
@ eBn

Search Drive
My Drive -

Name

B3 T services

- Management

E 2017-10-11.Template.IT Services

B 2017-10-11.Template.IT Transformation

Cambridge Presentation Template

You can find out more about Google Drive here:

https://gsuite.google.com/learning-center/products/drive/

Sharing

m 9 O

m My Drive X
DETAILS ACTIVITY
Today
09:46

0 You edited an item

B 1TSM Team Meetings

05:39

0 You edited an item

B 1T5M Team Meetings

Yesterday

Note that when sharing within Google Drive at Cambridge, you will be presented with the following

options:


https://gsuite.google.com/learning-center/products/drive/
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Link sharing

On — Public on the web

‘S

Anyone on the Internet can find and access this. Mo sign-in required

2 On-Anyone with the link

== Anyone who has the link can access. Mo sign-in required

Ba On — University of Cambridge
Anyvone at University of Cambridge can find and access.

By On - Anyone at University of Cambridge with the link

== Anyone at University of Cambridge who has the link can access.

® e Off — Specific people
Shared with specific people.
MNote: ltems with any link-sharing option can still be published to the web. Leam more

m Cancel Learn more about link sharing

The third and fourth options will restrict the documents to @cam.ac.uk account holders only. When
sharing, you will also have the option to for them to have editing permissions, document commenting

permissions (without editing of the actual document), or view only permission.

M. Moriarty (you)

[ ]
- mm2228@cam.ac.uk
&
- rgo22@cam.ac.uk ‘ s - ‘
Is the owner
- acb9?2@cam.ac.uk
v Can edit
Invite people: Can comment
Enter names or email addresses.. Can view
Set expiry...

Owner settings Learn more Comment and View access only
Prevent editors from changing aCCesSS Awwr g visws poops

Disable options to download, print and copy for commenters and viewers
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You can also prevent editors from changing other people’s permissions and adding new people, as well

as disabling other easy methods of document duplication.
Finally, note that you can set an expiry date on individuals’ access.

Team Drives

You can share documents with people individually or create folders shared by people who will - by
default - inherit the sharing permissions of that folder. However, any documents uploaded will retain
the ownership of its creator (unless this is transferred). This can present a difficulty when document
authors leave the institution and their account is deleted (it will also delete documents they own, even
when shared with other people who remain within the institution. Team Drives overcome this problem
by providing an area where any documents created within them are under the shared ownership of the

members of the Team Drive. Further instructions are available here:

https://gsuite.google.com/learning-center/products/drive/get-started-team-drive/

Linux

You can link Google Drive to your filesystem using google-drive-ocamlfuse:

https://github.com/astrada/google-drive-ocamlfuse

Note that Team Drive access is not currently supported.

Google Forms

Google Forms gives you the ability to create surveys. You can find out more here:

https://gsuite.google.com/learning-center/products/forms/

You can access this from within Google Drive by clicking the ‘More’ menu:


https://gsuite.google.com/learning-center/products/drive/get-started-team-drive/
https://github.com/astrada/google-drive-ocamlfuse
https://gsuite.google.com/learning-center/products/forms/
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e C { & Secure | https://drive.google.com

@ UNIVERSITY OF ) .
CAMBRIDGE [rjyve Q,  Search Drive
Google Apps @ Cambridge

“ My Drive > IT Services > [S] Projects (Standin

Folder
b
3  File upload
’ p
Folder upload
B Google Docs >
Google Sheets >
Google Slides >
More >
B Google Forms
B Bin B3 Google Drawings
E] Google My Maps
7 ME used
B Google Sites
<+  Connect more apps

Google Hangouts

You can learn more about Google Hangouts here:

https://gsuite.google.com/learning-center/products/hangouts/

Google Keep

You can learn more about Google Keep here:

https://gsuite.google.com/learning-center/products/keep/



https://gsuite.google.com/learning-center/products/hangouts/
https://gsuite.google.com/learning-center/products/keep/
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Google Sheets

You can learn more about Google Sheets here:

https://gsuite.google.com/learning-center/products/sheets/

Sheets also has version history functionality similar to Google Docs.

Google Slides

You can learn more about Google Slides here:

https://gsuite.google.com/learning-center/products/slides/

Note that the University of Cambridge template section has one template already:

e C { & Secure | https://drive.google.com

@ UNIVERSITY OF

CAMBRIDGE [rjye Q. Search Drive
Gaooghe Apps @ Cambradge

- -

Folder
b
[ ]
Fy File upload
; . g irvices
Folder upload
agement
B Google Docs >
Google Sheets 3 ~10-11.Template.IT Services
Google Slides >
Blank presentation
More ¥
From a template
B B


https://gsuite.google.com/learning-center/products/sheets/
https://gsuite.google.com/learning-center/products/slides/
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C () @& Secure | https://docs.google.com

+ SUBMIT TEMPLATE

Presentation designs

EE U O
AF AL

Cambridge Presentation
Template

About this document

This is a Google Doc document utilising Google Drawings (Menu: Insert>Drawing) into which

screenshots were pasted, and arrows added from the Drawings menu).

Links to heading were added via the menu: Insert>Link>Headings, e.g.

m Google Calendar
m Google Contacts (address book)
B Google Docs (and Google Drawings as part of Docs)

m Google Drive (free ‘unlimited’ cloud-based storage)

[ g
Text Google Drive
u
Link
]
- Headings
m Google g ve haven't teste
m Google [ Google Apps Information and Help
m Google T[ Background
1T Logging in
1T Google Drive
[ About this documen Google Drive
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It is shared with anyone within the @cam.ac.uk organisation - anyone with the link at the University of

Cambridge can view this document.

We will keep this document updated.

Support

Customers within the Cavendish Laboratory can contact us as follows:

IT Services

itservices.phy.cam.ac.uk

m it.helpdesk@phy.cam.ac.uk

m https://itservices.phy.cam.ac.uk



mailto:it.helpdesk@phy.cam.ac.uk
https://itservices.phy.cam.ac.uk/

